CHAPTER

QlI.

What is a Word Processor?

WORD PROCESSOR:

Q.2

A word processor more formally known as document preparation system 1s a
computer application program used for preparation of text-based documents.

Word processor can manipulate the textual data.
It also allows you to add images, sounds, charts and graphics in your document.

Word processors can create the hypertext document to publish on the World Wide
Web.

The advantage of word processing software over typewriter is that you can add and
change text written in word processing software very easily.
You can also print your document on any available printer.
There are two broad categories of word processing application software.
A Simple Word Processor (Text Editor)
Full-featured Word Processors
Discuss a Simple Word Processor and its features.

A SIMPLE WORD PROCESSOR/TEXT EDITOR:

Text editor is a simple word processor with only very basic features.
Text editors are used to create, edit and save simple text documents.

In Windows operating system notepad, WordPad are examples of simple word
processors or text editors.

A text editor provides the following basic features.

Insert Text
This feature allows you to enter text in the document.
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Delete Text

Entered text can be deleted as per requirement. You can erase characters, spaces,
words, complete sentences, paragraphs and even pages easily.
Cut and Paste

Cut allows you to move selected text from its original location and Paste feature
allows you to transfer it another location. To move text from one place to another is a
two step procedure. First cut it and then paste it at new location.

Copy
It will create the copy of selected text for duplication.

Page size and margin

This helps in managing the size of page and set it margins. Word processor will
automatically readjust text according to the page size and margins.

Find and Replace

This feature is used to find a piece of text, portion of a word or phrase. It also allows
replacing the found text with another piece of text.

Word Wrap

While typing when you have completed one line it will move your cursor on the
beginning of the next line. This feature is called word wrap.

Print

To create a hard copy of document we need to print it. This feature allows to print a
document.

Discuss a Full-featured Word Processor.

FULL-FEATURED WORD PROCESSOR:

Most word processors provide additional features that allow manipulating and formatting
documents more conveniently.

These advance word processors are also called full-featured word processors.

These full-featured word processors support the following features.

File Management
This feature allow to create, delete, move and search for files.
Font Specifications

Allow you to change the font of your text with in a document. For example you can
bold, italics or underline your text.

Footnotes

Footnotes are used in printed documents to explain, comment on, or provide
references for text in a document. You might use footnotes for detailed comments.



Cross-references

Cross-reference refers to an item that appears in another location in a document — for
example, "See Figure 1." You can create cross-references to headings, footnotes,
bookmarks, captions, and numbered paragraphs.

Graphics

This feature allows you to insert pictures and graphics into a document. Some word
processors also provide facility to create and edit the pictures and graphic objects
within the document.

Headers and Footers

Headers and footers are arecas in the top and bottom margins of each page in a
document. You can insert text or graphics in headers and footers for example, page
numbers, the date, a company logo etc.

Page Numbering

The word processor automatically keeps track of page numbers so that the correct
number appears on each page.

Layout

This feature allows you to specify page size, margins, indents and line spacing with a
document.

Macros

If you perform a task repeatedly in word processing software, you can automate the
task by using a macro. A macro is a series of commands and instructions that you
group together as a single key to accomplish a task automatically. All commands in a
macro are executed when a key assign to a macro is pressed.

Merges

It allows you to merge text from one file into another file. This is useful for creating

many files that have the same format but different data. Creating mailing labels is an
example of using merges.

Spell Checkers

This utility allows checking the wrong spelling of words in a document. It highlights
the misspelled words. Word processors have their own dictionary to check spellings.
Thesaurus

The thesaurus provides a list of synonyms for the text you look up, and highlights the
one that is closest to what you have typed.

Tables of Contents and Indexes

This feature allows you to automatically create a table of contents and index based on
the headings you have inserted in the document.

Document Windows

Document windows allow you to edit two or more documents at the same time. Each
document appears in the separate window.

WYSIWYG (What You See Is What You Get)

A document will appears on the display screen exactly as it will look when printed.



Q4. What s the interface of Word Processor?

STARTING TO USE WORD PROCESSOR:

To have a better understanding with a word processor you should be familiar with
its interface. Interface represents a way through which you can interact with the word
processing software.

THE WORD PROCESSOR’S INTERFACE:

Word processor’s interface consists of an edit window to write and edit text, a list of
several tools in the form of toolbars to manipulate the text and other objects of the
document.
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o Title Bar

It is the top most bar of the application window that contains the name of program.
e Menu Bar

It displays the names of all menus e.g. file menu, edit menu etc.
e Standard Tool Bar

It consists of various buttons representing different commands to perform tasks. It
provides the quick way to access the commonly used commands e.g. open, copy and
print a file.

e Formatting Tool Bar



The formatting toolbar contains buttons for formatting commands.

Ruler

It shows the positioning of text, margins, tabs indents and other elements on the page.
Document Window

A rectangular portion of the screen in which you view and edit a document.

Status Bar

It is the bottom most bar of a word processing software. It shows the position of
insertion point, and status of some important keys e.g. Insert and Caps Lock.

Entering and Editing Text

Qs.

In a document text is entered using keyboard.

The word processor places a cursor (insertion point) at the left upper side of the
document window.

While typing when you reach at the end of the line your cursor will automatically
moves to the beginning of the next line.

Word processor also allows changing text without retyping the whole document.
Changing and existing document is called editing the document.

There are many ways to edit an existing document e.g. by typing new or by replacing
an existing text with new one etc.

Discuss Typing Modes.

TYPING MODES:
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There are two typing modes in word processors
o Insertion Mode

In insertion mode new text is placed at the insertion point or current position.
o Overtype Mode

In overtype mode new text replaces the existing one.

Discuss the procedure of selecting, editing and formatting text.

SELECTING TEXT:

To make any change in attribute of text, it must be selected first.

In many cases you will need to change the character or paragraph format, copy or
move information, or delete information.



Word works on the "select, then do" principle. If you are a touch typist, you do not
have to move your fingers off the keyboard to select text.

Move the insertion point to the beginning of the text you want to select.
Use one of the key combinations from the following tables.

Select Text Using the Arrow Keys

Key Action
Shift + »L or Shift + T Select one line at a time
Shift + = or Shift + < Select one character at a time

Shift + Ctrl + = or Shift + Ctrl + <« |Select one word at a time

Shift + Ctel+ ¥ or Shift + Ctrl +T Select one paragraph at a time
Select Text Using The Home And End Keys

Key Action
Shift + Home Select from the insertion point to the beginning of the current line
Shift + End Select from the insertion point to the end of the current line

Shift +Ctrl +Home|Select from the insertion point to the beginning of the document

Shift + Ctrl + End (Select from the insertion point to the end of the document

Ctrl + A Select the entire document, regardless of where the insertion point is

ERASING TEXT:

Two keys are used to erase text from the document.

These two keys are Delete and Back Space keys.

The Delete key erase the characters from the right side of the cursor (insertion point).
Back Space key erase the characters from the left side of the cursor.

These keys erase one character at a time.

To erase more character first select them and then press Delete key.

Undo and Redo:

It 1s a good 1dea to undo an action as soon as you realize you made a mistake.



Undo erases the last change done to the document reverting 1t back to an older state.

Redo is used to reverse the previous undo.

FORMATTING TEXT:

To enhance the appearance and to improve readability of your documents you can
change the fonts, or apply attributes such as boldface, italic, underline, borders,

patterns, and colors.

Many of the formats you will use most often are accessible on the Formatting toolbar.
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Adds or removes a border
[[] - [|around selected text or A7 .
objects

Marks text so that it 1s
highlighted and stands out

A . Formats the selected text
— with the color you click

What is a font and formatting fonts? Discuss the types of fonts.

FORMATTING FONTS

It is appearance of text. Fonts represent the various typefaces used in printed materials.
The height of fonts is measured in points, and there are 72 points per inch.

You can also change many character attributes of fonts, such as applying bold, italic,
underline, or strikethrough to the text.

The font is basically appearance of characters.

One character can be represented in different fonts.

It can be said that font is a writing style of a character.

There are two general categories of fonts

SERIF

Serif fonts have extra decorative lines at the extremes of a character. Serif, or
"roman", fonts are named for the features at the ends of their strokes. Times Roman
and Garamond are common examples of serif fonts.

Serif fonts are probably the most used class in printed materials, including most
books, newspapers and magazines.

AaBbCc seiron
Aa B b C C  sans Serif Font

SANS-SERI

Sans-Serif has no extra decorative lines at the extremes of character. Arial is an
example of this category of font.
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Font Size:

e Font size can be changed from Formatting Toolbar and Font dialog box.
e Font dialog box can be displayed from format menu.

e A common font size used in business documents is 82-points type.

Font Style:

e Font style is used to bold, italicize and underline the text. Formatting Toolbar has
separate buttons for this and Font dialog also have these options.

Font Color:
e The color of font can be change. Normally black color is used for font.

e In addition to these basic characteristics many effects can also be applied to all types
of fonts. These are as follows.

e Strikethrough: It draws a line through the middle of the text.

e Shadow: It adds a shadow behind the text.

e Outline: It displays inner and outer boundaries of each character.
e Superscript: It raises the text and reduces font size like X°.

e Subscript: It lowers the text and reduces font size like X3.

e Emboss: It displays text as raised on the screen.

Q8. Discuss the procedure of Line spacing, and paragraph features.

LINE SPACING:



Line Spacing sets the amount ot space between lines within a paragraph.
Single spacing is the default.
The spacing for each line is set to accommodate the largest font on that line.

If there are smaller fonts on the line, there will appear to be extra space between lines
where the smaller fonts are located.

At 1.5 lines, the Line Spacing is set to one-and-a-half times the single-space amount.

For double-spaced lines, the line spacing is set to two times the single-space amount.

PARAGRAPH SPACING AND FEATURES OF PARAGRAPHS

Space Before sets the amount of space before the paragraph.
Space After sets the amount of space after the paragraph.

By default the paragraph spacing is same as the line spacing but it can be changed.



The space or distance between the page margin and the text in a paragraph is called
indent.

Indent can be set for first line and remaining paragraph separately.

First line indent option indent only the first line of a paragraph.and Hanging option
indent all but the fist line of a paragraph.

Alignment:

Controls how the text is positioned within a paragraph line (the left and right sides of
the paragraph. There are four types of alignment.

Alignment Hot key Toolbar button
Left Ctrl+L =
Right Ctrl+R &
Centered Ctrl+E %
Justified Ctrl+] =

Left the text is aligned to the left edge of the paragraph.
Right the text 1s aligned to the right edge of the paragraph.
Centerd the text is centered horizontally between the paragraph edges.

Justified the text of all the paragraph lines is expanded to fill the whole width of the
paragraph. The list line 1s the paragraph is aligned to the left.

In the days of the typewriter, fonts were mono-space characters (i.e., spaces between
characters were equal).

Computers use proportional space fonts (i.e., characters and spaces use only the
amount of space needed).

With mono-space fonts, you could press the space bar to align text, but if it is tried
with proportional space fonts, you may end up with undesired results, even if it looks
good on the screen.

To avoid problems with text alignment, use tabs rather than spaces.
The default tab settings for Microsoft Word are every half-inch.

If you do not like the Word settings, you can set your own tabs.



Q9. Whatis a procedure of borders and shading?
BORDERS AND SHADIN
e For a finished look, you can add borders and shading to your documents.

e A border could be a box surrounding a paragraph or multiple paragraphs, or a line on
one or more sides of the paragraphs.

e Horizontal and vertical lines are considered borders.
e A border can include shading or you can use shading without borders.

e Borders and shading are particularly useful in setting special paragraphs apart from
the rest of your text for emphasis.

Formatting a Page
e FEach document section has its own page settings.

e Page settings include the paper format (width, height), page orientation, margins, and
a few other characteristics shared by the section pages.

e When a document contains multiple sections, you can specify different page settings
for each section.

e For example, you could specify larger page margins for the first section, or the
landscape page orientation for the last section of this document.

e Some components of page settings are shared by all the document sections.

e  When you toggle "Mirror margins" or "Different odd and even headers/footers", the
whole document is affected, ie all the document sections.

Page Size:

e [tis very important while printing a document.

e We can set the size of page according to our requirement.

e Changing the size of page disturb the formatting.

e So it is strictly recommended to set the page size before going to format it.
e To change the page size select Page Setup from File menu.

Orientation:

e Dimensions of a document are called its orientation.

e By default the documents are set to use Portrait.

e In portrait document is taller than its width.

e The second option for orientation is Landscape. In landscape document’s width is
more than its height.

Page Margins
e Page margins are the blank space around the edges of the page.
e In general, you insert text and graphics in the printable area inside the margins.

e You can position some items in the margins for example, headers, footers, and page
numbers.



Q10. Whatis Header, Footer, page Number?

HEADER/FOOTER:

Headers and footers are areas in the top and bottom margins of each page in a document.

You can insert text or graphics in headers and footers for example, page numbers, the
date, a company logo, the document's title or file name, or the author's name that are
printed at the top or bottom of each page in a document.

You can select Header and Footer option from the View menu.

Page Numbers:

The word processor automatically keeps track of page numbers so that the correct
number appears on each page.

Q11. Whatis the procedure to create columns?
INTRODUCING COLUMN

Sometimes, you want to use columns in your document, especially if you're creating
some type of newsletter.

Formatting your document into columns is a quick and easy process.

To change your document layout to a multiple-column layout, start by positioning
your cursor where you want the multiple-column layout to begin.

From the Format menu, choose Columns. This will open the Columns dialog box.
From here, you can choose one of the Preset column styles - One column, Two
columns, Three columns, Left (two columns with the left column smaller than the
right) or Right (two columns with the right column smaller than the left).

You can also enter the number of columns you want to use from the Number of columns:
drop-down box. If you want a line between the columns, check the Line between boxes.
If you uncheck the Equal column width box, you will be able to change the width of
the columns and the amount of spacing between columns.
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e From the Apply to drop-down box, you can choose to apply the column layout to the
Whole document, This section of the document, or just From this point forward
in the document.

e If you only want to use columns in one part of the document, highlight the text you
want to change to a column layout before opening the Columns dialog box. From the
Apply to: drop-down box, choose Selected text.

e When using columns in a document, be careful that you don't use too many columns
on a page. This can make the document difficult to read.

Q12. What is the procedure to create Tables? Discuss different options of table
menu.

INTRODUCING TABLES

e Tables can be used for a variety of purposes.

e These include displaying data, listing related items and for producing columnar text.
e A table can be created easily and quickly in Microsoft Word 2000.

e By default the table is delimited with single lines which will print.

e Tables are good alternatives to tabs when you have more than one column of related
information to present.

e You can remove some or all of the lines or borders to create a tabbed effect.

e Within tables you can also add shading or colors, create formulae, change row height
and width, and sort the information within the table.

Creating a Table:
You can create a table by one of the following methods:
o Using the Table icon
o Using the Table menu
o Drawing the table using the Draw Table option
Creating a Table Using the Table Icon
™

The easiest way to create a table in Word is using the Table Icon shown here.

e C(lick where you want to insert the table, this ensures that the Insertion Point (cursor)
1S correctly positioned.



e C(Click on the Table icon on the Toolbar and, holding the left mouse button down, drag
until you have a table of the desired size: 3 rows and 3 columns in this example.
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e Release the mouse button and a table will be inserted at the Insertion Point in your
text.

Creating a Table Using the Menus
To create a table in Word using the menus carry out the following steps:
e Position the cursor at the point in the document where the table is required.

e Click on the Table menu and then on Insert You can then select Table from the sub
menu.

Inzert Table

L=
[x

Table size

Murnber of columns:

Murmber of rows: |h

AutoFit behavior
* Fixed colurnn width: |ﬂ.ut-:| il

" AukaFik bo contents

" AutoFit boowindow

Table Format  (none) dautoFormat. .. |

[ Set as default for new tables

(5] Cancel

e Enter the number of Rows and Columns required in the Dialog box.

e By default the column width is automatically determined so that the table will fill the
page horizontally. If you require specific column widths change the width from Auto
to the desired size then click on OK .



Inserting Kows and Columns:

Once the table 1s created additional rows can be added.

Place the cursor in the row or column where you want to adjust the new row or
column.

Select Table menu —— Insert —— Columns to the left or Columns to the right.

Much like inserting a row, add a new column by placing the cursor in a cell adjacent
to where the new column will be added.

Select Table menu —— Insert —— Columns to the Left or Columns to the Right.
Or, select the column, right-click with the mouse, and select Insert Columns.

Moving and Resizing a Table:

If the mouse is placed over the table a four-sided moving arrow and open box resizing
handle will appear on the corners of the table.

Click and drag the four-ended arrow to move the table and release the mouse button
when the table is positioned where you want it.

Click and drag the open box handle to resize the table.

Change the column widths and row heights by clicking the cell dividers and dragging
them with the mouse.

move handle

resize handle

Changing Table borders

The Tables ana sorders toolbar allows you to add border styles, shading, text effects,
alignment, and more options to your table. Access the toolbar by clicking

Table —— Draw Table or View —— Toolbars —— Tables and Borders.
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You will need to highlight the cells of the table you want to format.

Click and drag the mouse over the cells, or use the following shortcuts.



Table Properties
Use the Table Properties dialog box to modify the alignment of the table with the body
text and the text within the table. Access the box by selecting Tables — Table Properties.
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o Size: Check the Preferred width box and enter a value if the table should be an
exact width.

o Alignment: Highlight the illustration that represents the alignment of the table in
relation to the text of the document.

o Text wrapping: Highlight "None" if the table should appear on a separate line
from the text or choose "Around" if the text should wrap around the table.

o Borders and Shading: Select from a number of border styles, colors, and widths.
Click the Shading tab to change the background color and pattern.
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o Options: Click the Options button on the Table Properties window. To change
the spacing between the document text and the table borders under Default cell
margins. Check the Allow spacing between cells box and enter a value to add
space between the table cells.
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013. What is the procedure to Print Documents?
PRINTING A DOCUMENT

After completing the document if you want to print it out you can do this.
All word processing programs provide this facility.
The simplest way to print is to use the Print button on the Standard toolbar.

Word skips displaying the Print dialog box and uses the settings last defined or the
default settings.

When you click the Print button, one copy of the entire document prints to the default
printer.

You can also change print options by using the Print dialog box.
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Multiple Copies

You can print the multiple copies of the same document.

Select the collate option if you want o print the document in proper binding order.

Page Ranges

You can choose to print any page or combination of pages in the Print dialog box,
rather than printing the entire document.

Q14. What is Clipboard?
CLIPBOARD:

The clipboard is a temporary holding space in the computer’s memory.

The Microsoft Office Clipboard allows you to collect text and graphic items from any
number of Office documents or other programs and then paste them into any Office
document.

For example, you can copy some text from a Microsoft Word document, some data
from Microsoft Excel, a bulleted list from Microsoft PowerPoint, some text from
Microsoft FrontPage or Microsoft Internet Explorer and a datasheet from Microsoft
Access, then switch back to Word and arrange any or all of the collected items in
your Word document.

Office Clipboard works with the standard Copy and Paste commands.

Just copy an item to the Office Clipboard to add it to your collection, and then paste it
from the Office Clipboard into any Office document at any time.

The collected items stay on the Office Clipboard until you exit Office.
The last 12 elements that were cut or copied are placed onto Word's clipboard.

You can view the elements on the clipboard by selecting View —— Toolbars —>
Clipboard from the menu bar.

Clipboard (2 of 12) x|
E"ﬂ’ Paste Al |ﬁ

)

Place the mouse arrow over each element in the clipboard to view the contents of
each item and click on an element to add its contents to the document.

Click Paste All to add all of the items to the document at once.

Click the Clear Clipboard button (the icon with an "X" over the clipboard image) to
clear the contents of the clipboard.



Q15. Why we use TEXT BOXESN?
USING TEXT BOXES
e Sometimes you need to move text around a text box.

e You might want to create letterhead in which the body of letters wraps around the
block of material containing you name and address.
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e Text Box can be created by selecting Text Box from Insert menu or by just clicking
the Text Box icon from the drawing toolbar.

Q16. What are Graphics? Discuss the procedure for inserting Pictures and Auto
shapes

GRAPHICS
e All word processors also have the capability to handle graphics.
e Microsoft word has number of tools for manipulating graphics.

o These tools are divided into two main categories: those for bitmap graphics and for
vector images.

e Bitmaps are painted pictures and vector graphics are line drawings.
e Pictures can be added to the document by select picture option from insert menu.
e Pictures can be inserted from a file, clip art, from scanner or cameras.

e Charts and word art can also be added to a document in the same way.



Pictures:

Activate the image you wish to edit by clicking on it once with the mouse.
Nine handles will appear around the graphic.
Click and drag these handles to resize the image.

The handles on the corners will resize proportionally while the handles on the straight
lines will stretch the image.

More picture effects can be changed using the Picture toolbar.

The Picture toolbar should appear when you click on the image. Otherwise, select
View —— Toolbars —— Picture from the menu bar to activate it.

More/Less Line Format
Image Contro Brightness Style Picture
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o Imsert Picture will display the image selection window and allows you to change
the image.

o Image Control allows to make the image grayscale, black and white, or a
watermark.

o More/Less Contrast modifies the contrast between the colors of the image.
o More/Less Brightness will darken or brighten the image.

o Click Crop and drag the handles on the activated image to delete outer portions of
the image.

o Line Style will add a variety of borders to the graphic.

o Text Wrapping will modify the way the document text wraps around the graphic.
o Format Picture displays all the image properties in a separate window.

o Reset Picture will delete all the modifications made to the image.

AutoShapes:

AutoShapes option in drawing toolbar allows you to draw many different geometrical
shapes, arrows, flow chart symbols, stars and banners on the document.

The AutoShapes toolbar will allow you to draw many different geometrical shapes,
arrows, flow chart symbols, stars, and banners on the document.

Activate the AutoShapes toolbar by selecting Insert —— Picture —— AutoShapes
or View —— Toolbars —— AutoShapes from the menu bar, or clicking the
AutoShapes button on the Drawing toolbar.
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Click each button on the toolbar to view the options for drawing the shape.
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Q17. What are Word Art? Discuss the procedure for inserting Word Art.

Word Art is a feature of Microsoft Word's drawing program.

To access the Drawing toolbar, go to the View menu and select Toolbars ——> Drawing.
o The Drawing toolbar appears under the text near the bottom of the window.

e If you're not sure which button it is, run your mouse over each button on the toolbar
which has the letter A on it. The "Insert Word Art" box will appear.

o Use Word Art as a heading for creative essays or centered over or within columns.
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e Click on the WordArt button on the Drawing Toolbar to bring up the WordArt
Gallery.

e Click on a style to select it. This opens the Text dialog box.

e Type your text and select a Font, but accept the default Font Size as it can be adjusted
more effectively on the page.

e Click OK to place the WordArt on the page.

e The WordArt Toolbar should appear when you select the text and disappear when it is
deselected. If it doesn't appear, go to View —— Toolbars —— WordAurt.



Q.18 Discuss paragraph formatting.
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You can customize the text by using the different options on the WordArt Toolbar.

Paragraph formatting is related with the general appearance of your overall word

document.

You can change the alignment, indentation, and spacing between lines or before and

after paragraphs.

For Paragraph Formatting you’ll choose Format, and then Paragraph from main

mentu.
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